Quintic Software

Tutorial 7c

High-Speed Video Capture

(Video Capture via USB or GigE)
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1. Single High-Speed Capture

For installation details please refer toTtutorial 7b — High-Speed Camera Set-up.

Once you have completed the install procedure, double click on the Quintic software icon
on the computers desktop to open the Quintic software. Click on the ‘Camera’ tab in the

Main window and select ‘Single High-Speed Capture’. The camera window will open in

standby mode.
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To start the live camera preview click on the button, a live preview will now load, at
full 752 x 480 resolution.
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a. Camera Set-Up / Parameters
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To change the camera parameters click on the.

Displays the video capture
speed (fps)

button or select the ‘Camera’ tab

and the properties option from the drop down menu, this will open the properties window.

Any settings that are changed within the properties window will be saved and reloaded

next time the camera is opened.

Parameters can also be saved as an Ini file so that various frame rate, and resolution

settings can be saved for ease of use.
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b. Camera Tab (frame rate & exposure)

The camera tab allows the pixel clock frequency, frame rate and exposure time to be
altered.

Firstly check the ‘Optimum’ selection box, this will allow the software to run at the
optimal highest Pixel Clock Rate. This will improve/increase the maximum frame rate at

which the camera can capture at.
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Camera Peak Bandwidth is the maximum required bandwidth in MB/sec (Peak). If the

bandwidth is exceeded this is displayed in red.

Camera Average Bandwidth is the average bandwidth required in MB/sec. If the

bandwidth is exceeded this is displayed in red.

N.B. Make sure that these values don’t exceed the bandwidth, otherwise performance will

be impaired.
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Pixel Clock

Sets the clock rate at which the image data is read from the sensor. Altering this setting
affects frame rate and exposure time.

Frame Rate

Depending on your bandwidth value there are varying maximum amounts of frames per
second that can be captured. This value will decrease as the resolution value increases.
When setting the frame rate in freerun mode the camera will capture one image after

another at the set frame rate.

Hold: When this check box is selected the frame rate will remain at the set rate, if the pixel

clock changes.

Max: when this box is selected the camera will record at the maximum rate that is possible,
frame rate depends on the capture resolution and the pixel clock.

Auto: This option selects the Auto Frame Rate Function, this is only available when Auto

Exposure is selected.
Frame rate will change when the user sets a new area of interest (AOI) of image.

Utilising the highest frame rate possible is especially important when capturing fast
movements (e.g. the golf swing). A typical golf swing can occur at 100mph or 150ft/sec if

your camera is sampling at 30Hz the club will move 5 feet per 1/30 of a second.

In order to ensure that all actions are accounted for you must sample fast otherwise the

subtle movements will be lost.
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Example Resolution and Frame Rates:

1 80GHz Processor 1 Gb RAM 87 | 752=480 34 8§ MB/s
1 80GHz Processor 1 Gb RAM 98 | 700x450 348§ MB/s
1 80GHz Processor 1 Gb RAM 111 | 652x420 34 § MB/s
1 80GHz Processor 1 Gb RAM 132 | 600=390 34 8§ MB/s
1 80GHz Processor 1 Gb RAM 146 | 552x350 348§ MB/s
1 80GHz Processor 1 Gb RAM 158 | 500x320 34 § MB/s
1.80GHz Processor 1 Gb RAM 172 | 452x280 348 MB/s
1. 80GHz Processor 1 Gb RAM 194 | 400x250 34 8§ MB/s
1 80GHz Processor 1 Gb RAM 216 | 352x220 34 8§ MB/s
1 80GHz Processor 1 Gb RAM 243 | 300x190 34 § MB/s

Exposure Time

This is the amount of time the shutter remains open to allow light into the sensor in order

to form an image.

This option sets the exposure time. The available exposure time depends on the pixel clock
setting and the frame rate. A low frame rate setting allows long exposure times, where as a

high frame rate reduces the maximum possible exposure time.

Hold: When the check box is selected the exposure will remain at the desired setting if the

frame rate changes.

Max: The camera runs at the maximum exposure time that is possible at the current frame

rate.

Auto: this option selects the Auto Exposure Function, the exposure time changes

automatically depending on the selected frame rate.
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See the table below which illustrates exposure time and shutter speed settings.

Shutter Exposure Time
Speed (ms)
1/503 1.985
1/672 1.487
1/800 1.249
1/1010 0.99
1/1257 0.795
1/1457 0.686
1/1555 0.643
1/1666 0.6
1/18469 0.535
1/2032 0.492
1/2232 0.448
1/2469 0.405
1/2941 0.34
1/33467 0.297
1/3952 0.253
1/5319 0.188
1/6896 0.145
1/9803 0.102
1/12500 0.08

c. Image Tab (gain boost)

In digital imaging a voltage proportional to the amount of incident light is output at the
sensor. To increase image brightness and contrast, this signal can be amplified by an

analogue gain and offset before the digitising process.

Analogue amplification of the read-out pixel values increases overall image brightness and

contrast allowing for a height exposure value/shutter speed to be applied.
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Click on the ‘Gain Boost’ option within the Image tab, to automatically increase the

brightness and contrast of the image.
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d. Size Tab (video size, area of interest)

On this tab the user can set the image size parameters for your uEye camera.

Area of Interest (AOI)
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The area of interest function allows the user to centre the camera on the action they wish to

film by altering the resolution the camera captures at. These parameters allow the user to

select the size and position of the Area of Interest (AOI). AOI sets the camera so that only

data included within the specific area is captured. Using the AOI function to create a

smaller also enables the camera to capture at a higher frame rate.

Selecting the ‘Show Only AOI” box sets the camera preview to only display the AOI,

without a black border. This function saves memory and processing time when rendering

the image.

10 Tutorial 7¢ - High-Speed Video Capture




Width/Height

Sets the AOI width and height.

Left

Sets the left hand position of the AOI.

Selecting the ‘Centre’ box centres the AOI horizontally.
Top

Sets the top position of the AOI.

Selecting the ‘Centre’ box centres the AOI vertically.

Mirror Left/right / Up/Down

Select this check box to flip the image in the vertical or horizontal plane.
Binning

Binning allows the user to reduce the image resolution by the selected factor.
Using the binning factor will also increase maximum frame rate.

e. Using The Camera

-t

i

To start capturing video footage click on the button or select the ‘File’ tab from the

menu bar and then select record a video sequence from the drop down menu. Once selected

the Record dialog window will open.
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Before recording a video click on the ‘Create’ button, this will load the ‘Save As’

window, select the file directory where you wish to save your video and also select a file

name and then select ‘Save’.

To start capturing video footage click on the ‘Record’ button, the software will now

capture video until the ‘Stop’ button is selected or the video reaches the maximum frames

(if selected) or the maximal size (MB). To play the video within the Quintic software the

capture window must first be closed. To close the capture window after the video has been

captured click on the ‘Exit’ button.
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f. Other Functions
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Image Preview Controls

The user can control the size of the video preview screen by clicking on the ‘View’ tab and
selecting render or by using the display function buttons located on the menu.

NEEETTE

Disable the video preview

To disable the camera preview click on the EJ button this will disable the preview
screen.

Enable full screen video preview

To enable a full screen preview click on the E button, to exit out of full screen mode
click on the ‘Esc’ button.

N.B. in order to use this function Direct X 3D may need to be installed.

Scale the video preview to the window size.

To fit the preview video to the open window click on the 5 button this will scale the
open video preview to the current window size.

Scaling the display

The preview display can be scaled down to ¥ of the original size or up to twice the original
display size.

Displays the video preview at original size
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Scales the video preview to quarter size

E

Scales the video preview to double size
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Drawing tools

When using the preview screen drawing tools can be used to highlight key areas on the
screen although these shapes and lines won’t be saved to the video. Draw any of the shapes
by clicking on the shape button you require, moving the cursor over the screen to where
you want the shape to be, then holding down the left mouse button and dragging the shape
across the screen. To add text to the video preview screen, click on the area of the screen
where you want the text to appear and use the keyboard to type the desired text.

Circle Draw Tool Me asuriig Tool Text Tool
Freehand Draw Tool 7 2 ‘\% (Y &P |——TFraser Tool

Straight line Draw Tool Rectangle Draw Tool

Screenshot

When using the preview screen a screenshot can be captured and imported into another
program. To import a screenshot click on the button, this will save a copy of the
frame to the internal memory. To import the screenshot into another program click on the
paste function or press the Ctrl button + the “V’ button.

Display Rate.
The video frame rate can be limited to 30fps. To set the display rate to 30fps click on the

button.

Standby / close camera

i

To close or set the camera on to standby mode click on the button.
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2. Multi High-Speed Capture

For installation details please refer to the information found on your installation disc and
Tutorial 7b - High-Speed Camera Set-up.

From the ‘Camera’ tab select ‘Multi High-Speed Capture’.

Q Quintic Biomechanics 9.03 v21 EI@@
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Depending on the number of cameras present, you will see that number in the screen
below.

If however, you have a blank screen, you will need to ensure you have followed the
installation steps correctly. First, check the Camera ID numbers with the IDS Camera
Manager. Please refer to Tutorial 7b - High-Speed Camera Set-up for instructions.

N.B. The maximum recording time for one file is 5 minutes.
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It is possible to pause and continue, or It is possible to change the Camera exposure
stop recording. time using the slider bar should you require.

|Q| Quintic Multi Capture High-Speed

Refording Control Camera Control

P
%S’} Stop Record Start | Camera 1 |Camera AgCamera 3 | Camera 4 | Camera 5 | camera 6|
U
Exposure Time (us) 3447 Strobe Light
\Ahlete Database\Sample] File Name: ExampleCapture

Frames Delivefed: 34  Images dropped: 0  Frame Rate:100 Frames Delivered: 33 Images dropped: 0  Frame Rate:100 Frames Delivered: 31 Images dropped: 0 | Frame Rate:100

Frames Delivefed: 30  Images dropped: 0  Frame Rate:100 Frames Delivered: 28  Images dropped: 0

Frame Rate:100 Frames Delivered: 27  Images dropped: 0 | Frame Rate:100

Select the destination folder you wish to If you are using an IR ring light
save the video files, enter a file name, and you can control this here.

start recording. This must be on the C

Drive.

Once recorded, please return to Quintic Biomechanics, Main Tab, click on file open and view
your recorded images.

Using v21/v26, if you open *Cam1.avi you will have the option to open all the associated
videos in the across the number of windows you have open. These videos will automatically
be synchronised.
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